


Chapter 2 – Working with Images and Links  

 
MULTIPLE CHOICE 

 

 1. ____ is/are an important part of Web site content by describing the purpose of the site and conveying 

valuable details related to the site’s subject matter. 

a. Images c. Links 

b. Text d. Videos 
 

 

ANS: B PTS: 1 REF: EW 72 

 

 2. ____ help to organize a site by providing navigation to other areas of the site. 

a. Images c. Links 

b. Files d. Folders 
 

 

ANS: C PTS: 1 REF: EW 72 

 

 3. Adding ____ to a Web site increases a site’s attractiveness but adds complexity in terms of increased 

page file sizes. 

a. images c. files 

b. links d. colors 
 

 

ANS: A PTS: 1 REF: EW 74 

 

 4. Image files that exceed ____ kilobytes in size can download slowly in a visitor’s browser. 

a. 25 c. 75 

b. 50 d. 100 
 

 

ANS: D PTS: 1 REF: EW 74 

 

 5. Image files are composed of dots, or ____, which are the smallest amount of visible data in an image. 

a. pixels c. points 

b. trixels d. picas 
 

 

ANS: A PTS: 1 REF: EW 74 

 

 6. A file ____ is the way the file is encoded and stored electronically. 

a. format c. style 

b. tag d. index 
 

 

ANS: A PTS: 1 REF: EW 75 

 

 7. ____ compression means that a certain amount of image quality is lost when the file size is reduced. 

a. Lossless c. Squeezy 

b. Lossy d. Resizing 
 

 

ANS: B PTS: 1 REF: EW 75 

 

 8. With ____ compression, an image retains its quality. 

a. lossy c. lossless 

b. squeezy d. resizing 
 

 

ANS: C PTS: 1 REF: EW 75 

 

 9. For photographs, you should use ____ file compression. 



a. lossy c. resizing 

b. squeezy d. lossless 
 

 

ANS: D PTS: 1 REF: EW 75 

 

 10. The .gif image file format uses ____ file compression. 

a. squeezy c. lossy 

b. lossless d. resizing 
 

 

ANS: B PTS: 1 REF: EW 75 

 

 11. The .jpg image file format uses ____ file compression. 

a. lossy c. resizing 

b. squeezy d. lossless 
 

 

ANS: A PTS: 1 REF: EW 75 

 

 12. Because some visitors to your site might have a vision impairment, you should complete the 

information in the ____ dialog box that opens when you insert an image. 

a. Adaptive Properties c. Page Properties 

b. Accessibility Properties d. File Properties 
 

 

ANS: B PTS: 1 REF: EW 75 

 

 13. The ____ image file format is used for photographs. 

a. .gif c. .jpg 

b. .xlsx d. .png 
 

 

ANS: C PTS: 1 REF: EW 75 

 

 14. ____ use a series of motions and sounds to make an image appear to be moving. 

a. Pictures c. Links 

b. Animated graphics d. Divs 
 

 

ANS: B PTS: 1 REF: EW 76 

 

 15. An Expression Web site consists of at least one ____ and file. 

a. page c. folder 

b. image d. link 
 

 

ANS: C PTS: 1 REF: EW 77 

 

 16. When you open a Web site, all of the site’s files and folders appear in the ____. 

a. Folder List c. Page List 

b. File List d. Navigation List 
 

 

ANS: A PTS: 1 REF: EW 77 

 

 17. You can open an existing Web site by clicking the Open Site command on the ____ menu. 

a. Site c. Tools 

b. Edit d. Task Panes 
 

 

ANS: A PTS: 1 REF: EW 78 

 

 18. As you work with ____, it is helpful to display the rulers as a guide for cropping and resizing. 

a. links c. margins 

b. text d. images 
 



 

ANS: D PTS: 1 REF: EW 84 

 

 19. Having too many panels open makes your ____ cluttered and leaves you less room for editing. 

a. editing window c. workspace 

b. Common toolbar d. Toolbox 
 

 

ANS: C PTS: 1 REF: EW 84 

 

 20. The ____ appear along the left and top edges of the window when displayed. 

a. rulers c. toolbars 

b. menus d. task panes 
 

 

ANS: A PTS: 1 REF: EW 87 

 

 21. The ____ command is a toggle command, meaning that the same steps are used to turn the rulers on or 

off. 

a. Hide Ruler c. Close Ruler 

b. Show Ruler d. Open Ruler 
 

 

ANS: B PTS: 1 REF: EW 88 

 

 22. To maintain the aspect ratio when resizing an image manually, drag a ____ sizing handle. 

a. top c. corner 

b. bottom d. left or right 
 

 

ANS: C PTS: 1 REF: EW 89 

 

 23. After you have changed an image’s height and/or width, you should ____ it to improve the image 

quality by adjusting the resolution of pixels to the new image size. 

a. resize c. restore 

b. resample d. repair 
 

 

ANS: B PTS: 1 REF: EW 89 

 

 24. You can double-click a picture to open the ____. 

a. Insert Pictures from File menu c. Folder List task pane 

b. Format Pictures dialog box d. Picture Properties dialog box 
 

 

ANS: D PTS: 1 REF: EW 93 

 

 25. You can choose to align text and pictures at the ____. 

a. left margin c. right margin 

b. center of the page d. all of the above 
 

 

ANS: D PTS: 1 REF: EW 93 

 

 26. When positioning text around an image, use the ____ feature. 

a. image flowing c. alignment management 

b. text wrapping d. none of the above 
 

 

ANS: B PTS: 1 REF: EW 93 

 

 27. You can surround an image with lines, graphics, or effects by choosing an option in the ____ dialog 

box. 

a. Picture Properties c. Image Formatting 

b. Borders and Shading d. Lines and Graphics 
 



 

ANS: B PTS: 1 REF: EW 95 

 

 28. Image margins are measured in ____. 

a. picas c. centimeters 

b. inches d. pixels 
 

 

ANS: D PTS: 1 REF: EW 95 

 

 29. The ____ image enhancement option removes unwanted parts of a picture. 

a. layering c. cropping 

b. beveling d. flipping 
 

 

ANS: C PTS: 1 REF: EW 99 

 

 30. Applying a three-dimensional frame to an image using shadows is called ____. 

a. beveling c. layering 

b. resampling d. cropping 
 

 

ANS: A PTS: 1 REF: EW 99 

 

 

 

 31. As shown in the accompanying figure, you can click the ____ button below a resized image, then click 

the Resample Picture to Match Size option to resample the image. 

a. Picture Tasks c. Picture Actions 

b. Picture Formatting d. Picture Menu 
 

 

ANS: C PTS: 1 REF: EW 101 

 



 

 

 32. You can click the ____ button on the Pictures toolbar to change the pointer to the transparency pointer, 

as shown in the accompanying figure. 

a. Transparency c. Hide Background 

b. Set Transparent Color d. none of the above 
 

 

ANS: B PTS: 1 REF: EW 102-EW 103  

 

 33. The ____ temporarily stores text or page elements so that you can move or copy them to other pages or 

locations. 

a. Paste task pane c. Toolbox 

b. Folder List d. Clipboard 
 

 

ANS: D PTS: 1 REF: EW 103 

 

 34. You can click the Folder command on the ____ submenu of the File menu to add a folder to the site. 

a. Common toolbar c. Toolbox 

b. New d. Add 
 

 

ANS: B PTS: 1 REF: EW 116 

 

 35. A(n) ____ is a page anchor that is attached to a specific portion of the page. 

a. link c. bookmark 

b. image d. tab 
 

 

ANS: C PTS: 1 REF: EW 120 

 

 36. You can click the Hyperlink command on the ____ menu to insert a hyperlink. 

a. File c. Insert 

b. Edit d. Tools 
 

 

ANS: C PTS: 1 REF: EW 121 

 

 37. To test a link in the editing window, you must press and hold the ____ key as you click the link. 

a. ALT c. SHIFT 

b. CTRL d. TAB 
 



 

ANS: B PTS: 1 REF: EW 122 

 

 38. You can press the ____ keyboard shortcut keys to open the Insert Hyperlink dialog box. 

a. CTRL+K c. SHIFT+K 

b. CTRL+H d. SHIFT+H 
 

 

ANS: A PTS: 1 REF: EW 123 

 

 39. You can click the ____ button on the Common toolbar to preview a Web page in a browser. 

a. Launch Browser c. Preview 

b. Browser Preview d. Preview in browser 
 

 

ANS: D PTS: 1 REF: EW 126 

 

 40. You can press the ____ keyboard shortcut keys to open the Bookmark dialog box. 

a. CTRL+K c. CTRL+G 

b. CTRL+S d. CTRL+P 
 

 

ANS: C PTS: 1 REF: EW 134 

 
MULTIPLE RESPONSE 

 

Modified Multiple Choice 

 

 1. A navigation area might appear ____ the masthead on each page of a site. 

a. on the left side of c. on the right side of 

b. below d. above 
 

 

ANS: A, B PTS: 1 REF: EW 72 

 

 2. Web site images can perform which of the following purposes? 

a. illustrating a product catalog c. serving as links 

b. displaying a company’s logo d. adding visual interest and continuity 
 

 

ANS: A, B, C, D PTS: 1 REF: EW 72 

 

 3. Which of the following considerations are important to guide the reader’s eye and distinguish each 

image on a page? 

a. image borders c. spacing around each image 

b. image placement d. image background color 
 

 

ANS: A, B, C PTS: 1 REF: EW 74 

 

 4. Which of the following are common image file format types used for Web pages? 

a. .docx c. .jpg 

b. .gif d. .png 
 

 

ANS: B, C, D PTS: 1 REF: EW 75 

 

 5. Which of the following can you perform to adjust the workspace? 

a. undock a panel c. dock a panel 

b. close a panel d. maximize a panel 
 

 

ANS: A, B, C, D PTS: 1 REF: EW 84 

 



TRUE/FALSE 

 

 1. A site without graphics or that is difficult to navigate will likely hold a visitor’s attention.  

 

ANS: F PTS: 1 REF: EW 72 

 

 2. When adding images and links to a Web site, you should keep in mind the goals of the site.  

 

ANS: T PTS: 1 REF: EW 74 

 

 3. You should always make sure that you have proper permission to use an image before you add it to 

your site. 

 

ANS: T PTS: 1 REF: EW 74 

 

 4. Linking to external Web sites can confuse site visitors and should be avoided.  

 

ANS: F PTS: 1 REF: EW 74 

 

 5. High-resolution images contain a low concentration of dots per inch (dpi).  

 

ANS: F PTS: 1 REF: EW 74 

 

 6. Image file formats for use on the Web differ in how they reduce the size of image files by removing 

extraneous file data. 

 

ANS: T PTS: 1 REF: EW 75 

 

 

 



 7. Photos that have lost considerable quality appear pixilated and display blocks of color, as shown in the 

accompanying figure. 

 

ANS: T PTS: 1 REF: EW 75 

 

 8. Alternate text appears next to an image while it downloads and provides information to those who use 

devices to assist with visual impairments. 

 

ANS: T PTS: 1 REF: EW 75 

 

 9. When you want to align and position an image separately from surrounding text, insert the image into 

the same div as the text. 

 

ANS: F PTS: 1 REF: EW 76 

 

 10. If you use an Internet Explorer window to open one page or file of a site at a time, you can create 

errors of inconsistency and broken links.  

 

ANS: F PTS: 1 REF: EW 77 

 

 11. Minimizing a panel allows you to view less of another panel in the same column.  

 

ANS: F PTS: 1 REF: EW 84 

 

 12. You can click the Ruler and Grid command on the Insert menu to turn on the vertical and horizontal 

rulers. 

 

ANS: F PTS: 1 REF: EW 88 

 

 13. Resizing an image can make your layout more attractive and changes the file size of the image.  

 

ANS: F PTS: 1 REF: EW 89 

 

 14. Changing the alignment and spacing of text and images allows you to create a flow to your page that is 

visually interesting. 

 

ANS: T PTS: 1 REF: EW 93 

 

 15. An image’s margins separate it from adjacent text or images.  

 

ANS: T PTS: 1 REF: EW 95 

 

 16. Padding is space between an image and its border. 

 

ANS: T PTS: 1 REF: EW 95 

 

 17. Beveling, when added to an image, remove the image’s background.  

 

ANS: F PTS: 1 REF: EW 99 

 

 18. You can press the CTRL+V keyboard shortcut keys to copy a selected image.  

 

ANS: F PTS: 1 REF: EW 105 

 



 19. You can create a thumbnail by selecting an image and clicking the Create Thumbnail button on the 

Pictures toolbar. 

 

ANS: F PTS: 1 REF: EW 115 

 

 20. When you move an image using the Folder List, Expression Web automatically adjusts any coded 

references to the image file location. 

 

ANS: T PTS: 1 REF: EW 116 

 

 21. You can use external links to let visitors move around within long pages at your site.  

 

ANS: F PTS: 1 REF: EW 120 

 

 22. Internal links point the visitor’s browser to a site that is outside of your own Web site. 

 

ANS: F PTS: 1 REF: EW 120 

 

 23. Every page in a site should have a navigation bar that appears in the same location on a page.  

 

ANS: T PTS: 1 REF: EW 120 

 

 24. An e-mail link opens a new, blank e-mail window using the visitor’s e-mail program.  

 

ANS: T PTS: 1 REF: EW 137 

 

 

 

 25. A ScreenTip added to a mailto link provides visitors with additional information, as shown in the 

accompanying figure. 

 

ANS: T PTS: 1 REF: EW 138 

 
COMPLETION 

 

 1. ____________________ in Web pages can serve a practical purpose by illustrating a product or 

service described in the text.  

 

ANS:  

Graphics 

Images  

 

PTS: 1 REF: EW 72 

 

 2. All images included in your site need to be ____________________, or saved as part of the Web site.  



 

ANS: embedded 

 

PTS: 1 REF: EW 74 

 

 3. Higher-quality images contain a high concentration of ____________________ per inch.  

 

ANS: dots 

 

PTS: 1 REF: EW 74 

 

 4. The image file formats used for Web pages differ in how they ____________________ image files.  

 

ANS: compress 

 

PTS: 1 REF: EW 75 

 

 5. When you insert an image into a Web page, Expression Web automatically creates a(n) 

____________________ to contain the image. 

 

ANS: paragraph 

 

PTS: 1 REF: EW 76 

 

 6. Expression Web contains ____________________ default panels docked on the left and right sides of 

the editing window. 

 

ANS: four 

 

PTS: 1 REF: EW 84 

 

 7. ____________________ a panel allows you to move the panel to a fixed location on a side of the 

Expression Web window.  

 

ANS: Docking 

 

PTS: 1 REF: EW 84 

 



 

 

 8. You can view a menu of Expression Web panels by clicking Panels on the ____________________, 

as shown in the accompanying figure. 

 

ANS: menu bar 

 

PTS: 1 REF: EW 84-EW 85  

 

 9. Expression Web saves the arrangement of the ____________________ and uses it as the default the 

next time you start the program.  

 

ANS: workspace 

 

PTS: 1 REF: EW 84 

 

 10. You can change an image’s height and width by changing options on the Appearance tab in the 

____________________ dialog box. 

 

ANS: Picture Properties 

 

PTS: 1 REF: EW 90 

 

 11. Adding _____________________ to an image increases the space between the image and the 

surrounding text and helps the image to stand out. 

 

ANS: margins 

 

PTS: 1 REF: EW 97 

 



 12. ____________________ stacks images on top of each other, specifying the order in which the images 

appear. 

 

ANS: Layering 

 

PTS: 1 REF: EW 99 

 

 13. The ____________________ image enhancement effect makes colors brighter or duller.  

 

ANS: brightness 

 

PTS: 1 REF: EW 99 

 

 14. You can make changes to an image to increase its relevance, appearance, and 

____________________. 

 

ANS: usability 

 

PTS: 1 REF: EW 99 

 

 15. You can use buttons on the ___________________ toolbar to enhance an image in a variety of ways.  

 

ANS: Pictures 

 

PTS: 1 REF: EW 98 

 

 16. The ____________________ command on the File menu saves the changes you have made to all the 

pages in the site. 

 

ANS: Save All 

 

PTS: 1 REF: EW 105 

 

 17. A(n) ____________________ version of an image file is a small rendition that serves as a preview of 

the large version. 

 

ANS: thumbnail 

 

PTS: 1 REF: EW 111 

 

 18. ____________________ within the same page are called bookmarks.  

 

ANS: Internal links 

 

PTS: 1 REF: EW 120 

 

 19. E-mail links are also called ____________________ links.  

 

ANS: mailto 

 

PTS: 1 REF: EW 120 

 

 20. A(n) ____________________ is a window containing descriptive text that appears when you position 

the mouse pointer over a button or link. 



 

ANS: ScreenTip 

 

PTS: 1 REF: EW 138 

 
MODIFIED TRUE/FALSE 

 

 1. A lower file resolution delivers a better quality of image. 

 

____________________ 

 

ANS: F, higher 

 

PTS: 1 REF: EW 74 

 

 2. If an image file has a low resolution (low res), the image can appear jagged, or sizalated. 

 

____________________ 

 

ANS: F, pixilated 

 

PTS: 1 REF: EW 74 

 

 3. You have to balance the quality of an image with how its size affects the site. 

 

____________________ 

 

ANS: T   PTS: 1 REF: EW 74 

 

 4. A margin around an image can give it definition and distinction. 

 

____________________ 

 

ANS: F, border 

 

PTS: 1 REF: EW 95 

 

 5. Depending on a user’s Internet connection, the speed at which a site’s contents download into his or 

her browser can vary. 

 

____________________ 

 

ANS: T   PTS: 1 REF: EW 111 

 
MATCHING 

 

Identify the letter of the choice that best matches the phrase or definition. 

a. image f. Alternate Text text box 

b. links g. resample 

c. high resolution h. text wrapping 

d. embedded i. bookmark 

e. lossy j. external link 
 

 



 1. Text or graphics clicked to jump to new Web page 

 

 2. Contains the Accessibility Properties dialog box 

 

 3. Images saved as a part of the Web site 

 

 4. Internal page link 

 

 5. Improve image quality by adjusting the resolution of pixels to the new image size 

 

 6. Company logo on a Web page  

 

 7. Link that allows visitors to go to a Web page outside the current site  

 

 8. Quality is lost during image compression 

 

 9. A high concentration of dots per inch (dpi) 

 

 10. Feature that guides how text flows around an image  

 

 1. ANS: B PTS: 1 REF: EW 72 

 

 2. ANS: F PTS: 1 REF: EW 82 

 

 3. ANS: D PTS: 1 REF: EW 74 

 

 4. ANS: I PTS: 1 REF: EW 120 

 

 5. ANS: G PTS: 1 REF: EW 89 

 

 6. ANS: A PTS: 1 REF: EW 72 

 

 7. ANS: J PTS: 1 REF: EW 120 

 

 8. ANS: E PTS: 1 REF: EW 75 

 

 9. ANS: C PTS: 1 REF: EW 74 

 

 10. ANS: H PTS: 1 REF: EW 93 

 
ESSAY 

 

 

 

 1. Using the accompanying figure, briefly explain the role of the image on the Boon Mountain Resort 

home page.  

 

ANS:  



Visitors to a Web site want to get an impression of the site’s products or services very quickly. The 

eye-catching image on the Boon Mountain Resort home page is used to inform site visitors about the 

resort and to attract current and potential customers.  

 

PTS: 1 REF: EW 72 TOP: Critical Thinking  

 

 2. Briefly discuss the guidelines for selecting and storing Web site images.  

 

ANS:  

When deciding on how to enhance your site with images, consider both the aesthetic value of 

each image and whether the image conveys the necessary information or message to visitors 

to your site. Choose only images that are necessary to enhance the site and inform visitors, 

and make sure to seek permission where necessary. 

 

Store the images in a central folder location, and make sure that you have the proper permissions to 

use them. Acquire permission to use non-original images, give credit to the source, and make sure that 

you are using the image according to the agreement with the source and any guidelines that may have 

been set. 

 

PTS: 1 REF: EW 76 TOP: Critical Thinking  

 

 

 

 3. Using the accompanying figure, list the steps to align an image at the right margin and wrap the text 

around it. 

 

ANS:  

1. Open the Picture Properties dialog box and click the Appearance tab. 

2. Click the Right button in the Wrapping style section. 



3. Click the OK button to close the dialog box and apply the text wrapping style. 

4. Press CTRL+S to save the page.  

 

PTS: 1 REF: EW 94 TOP: Critical Thinking  

 
CASE 

 

Critical Thinking Questions 

Case 2-1 

 

You are planning a new small business Web site and are considering the images that you want to add 

to pages at the site. You discuss your plans with two of your classmates, Jim and Steve.  

 

 1. During your discussion with Jim and Steve, you ask about the best image file format to use for your 

site’s images. After the discussion, you decide to ____. 

 

a. use .png images for photographs and a .gif 

image for your company logo 

c. use .gif images for both photographs and 

your company logo 

b. use .gif images for photographs and a .png 

image for your company logo 

d. use .jpg images for photographs and a .png 

image for your company logo 
 

 

ANS:  

D 

 

PTS: 1 REF: EW 75 TOP: Critical Thinking  

 

 2. You also discuss the importance of images at your site with Jim and Steve. After the discussion, you 

decide to ____. 

 

a. add as many images as you can find, 

because most site visitors prefer images to 

text 

c. take a class on creating a neat company 

logo using a graphics design program 

b. select a few relevant images that help 

convey your site’s message 

d. forego adding images, the text is what is 

most important to visitors 
 

 

ANS:  

B 

 

PTS: 1 REF: EW 76 TOP: Critical Thinking  

 

Critical Thinking Questions 

Case 2-2 

 

You are working on the design plan for your new informational Web site. It is time to plan the 

navigational links for your site. 

 

 3. One of your pages will have content that spans at least three browser screens and visitors will have to 

scroll up and down to see all the content. To make the page easier for visitors to use, you decide to add 

____ that visitors can click to jump to individual sections of the page and back to the top of the page. 

 

a. navigation bars c. external links 

b. bookmarks d. toolbar buttons 
 



 

ANS:  

B 

 

PTS: 1 REF: EW 120 TOP: Critical Thinking  

 

 4. To provide additional information to visitors at your site, you want to refer them to other relevant sites. 

To do this, you add ____ to a “Check This Out” page at your site. 

 

a. bookmarks c. external links 

b. internal links d. button links 
 

 

ANS:  

C 

 

PTS: 1 REF: EW 120 TOP: Critical Thinking  


